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1 GUITAR RIG の世界へようこそ!
 

GUITAR RIG KONTROL はギターとベースプレーヤー用の完全なソリューションです。 ステージで即使用
することが可能な付属の RIG-KONTROL フットペダルを用いて、 内蔵オーディオインターフェイスによる
GUITAR RIG のスタジオ品質のサウンドを操ることが可能です。 当然 GUITAR RIG での使用に最適な設計
が施されていますが、 仕様規格及び MIDI サポートは殆どのプロ用オーディオソフトウェアに対応していま
す。
RIG KONTROL は電源付高速 USB 2.0 を介して使用しているコンピュータへと接続します。 これには 2
つのインプットがあり、各楽器またはラインレベルシグナルに対応します。 2 チャンネルのラインアウト端
子でモニターシステムにシグナルを送信、1 つのステレオジャックはヘッドフォンでのモニタリングに対応し
ます。
コントローラーとして RIG KONTROL には 9 つのスイッチとペダルがあり、GUITAR RIG の機能全般をコ
ントロールします。 更に MIDI と 2 つのアナログインプットで外部コントローラーへと接続します。
以下の章では RIG KONTROL の各機能と最適な使用方法について解説しています。 この製品に慣れ親しん
で頂く為に、このマニュアルを熟読することをお勧めします。

GUITAR RIG の世界へようこそ!
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2 ご使用の前に – 注意事項
 

GUITAR RIG を使用する前にこの章を詳しく読み、内容を把握してください。

2.1 シリアルナンバーとネームプレート
 

GUITAR RIG Kontrol では 2 つのシリアルナンバーを用意しています。 RIG KONTROL のシリアルナンバ
ーは、製品モデル名称と使用情報等と同様に、ハードウェアの底部に表示されています。 GUITAR RIG を製
品起動する為のシリアルナンバーは製品 DVD のスリーブに記載されています。

2.2 安全に使用するために
 

以下の項目を熟読し、本製品の破損、故障等の原因となる要因を避けてください。

2.2.1 警告
 

聴覚への悪影響を避けるために以下の警告内容を確認してください。
▪ 本製品をアンプ、ヘッドフォン、スピーカー、等と共に使用することで、聴覚に障害をもたらす音量を生

成することがあります。
▪ 過度な音量再生を防ぐ為に、RIG KONTROL を使用する際には全ボリュームをまず最小値に絞ってから

使用をはじめることを強く推奨します。 その後、音量を最適な音量に設定してください。
▪ ボリュームを大音量の設定にしたまま長期にわたって使用しないでください。聴力低下や耳鳴りの症状

が現れた場合には、すぐに医師の診察を受けてください。

2.2.2 注意
 

RIG KONTROL コントローラー及び、接続してある他の機器の故障を防ぐ為に以下の項目を熟読、把握して
ください。
▪ 機器を開けて分解や内蔵部品を改造しないで下さい。この機器には個人で修復できる部品はありません。

機器に故障等の問題が見られる場合は直ちに使用をやめ、専門の業者にご相談ください。
▪ 機器を雨天、及び水のある場所、湿気の多い場所で使用しないでください。
▪ 機材の破損につながる物や液体をハードウェアに置いたりかけたりしないでください。
▪ 異常高温状況下での使用、保管 (例、車内での直射日光に機器をさらす、または暖房器具に近接した状況

下での保管)、または振動の多い場所での使用、保管を避けてください
▪ RIG KONTROL を落下する可能性のある場所で使用しないで下さい。 本製品を移動する際には、接続し

ているケーブル類を全てはずして移動してください。

ご使用の前に – 注意事項
シリアルナンバーとネームプレート
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▪ 各機器の電源のスイッチ入切の際には、必ず全ての音量ボリュームを最小値にしてください
▪ ノブ、コネクター部に過度の力をかけて使用しないでください。
▪ RIG KONTROL を清掃する際は、乾燥した柔らかい布を使用してください。 シンナーや、ベンジン、洗

剤当の薬液、又は薬液のしみこんだ清掃用布は使用しないでください。

2.2.3 廃棄処分時の注意点
 

製品が修理不可能な状態になった場合、または製品を主文する場合は、お住まいの国が取り決めた法律に従っ
て、電化製品の正規廃棄手順を取り廃棄してください。

2.3 免責事項
 

Native Instruments GmbH は RIG KONTROL の改造、または間違った使用法によるデータ及び機器の各故
障、紛失、破損に対し一切の責任を負いません。
これらの情報はこのマニュアルが印刷またはデジタル資料として出版されるまでの最新版です。しかしなが
ら Native Instruments はこの製品に関するアップデートの権限を有し、製品の内容と本仕様書は予告なし
に変更される場合があります。

ご使用の前に – 注意事項
安全に使用するために
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3 RIG KONTROL ハードウェア
 

このセクションでは RIG KONTROL ハードウェアの概要を紹介します。

3.1 トップパネル
 

RIG KONTROL のトップパネルです。

(1) 各フットスイッチはソフトウェア上でプリセット内容の設定、各コンポーネントのオンオフ切り替え等の
各機能をアサイン可能です。 各スイッチには起動状態を示す LED が備わっています。 最上段には
GUITAR RIG で頻繁に使用する機能がデフォルトアサインされています。
(2) ソフトウェア上で連続的に変化するパラメーター (ボリューム、ワウワウ等) は、エクスプレッションペ
ダルでコントロールします。 ペダルの下には自由にアサイン可能なスイッチが搭載されています。
(3) 現在選択しているプリセット番号を表示します。
(4) この LED メーターでオーディオシグナルの入力値を表示します。 赤色 LED はクリッピングが生じたと
きに点灯します。 クリッピングが生じる場合は、関係するインプットゲインを下げてください。

RIG KONTROL ハードウェア
トップパネル

 

RIG KONTROL 3 - オペレーション マニュアル - 10



(5) この LED メーターでオーディオシグナルのアウトプット値を表示します。 赤色 LED はクリッピングが
生じたときに点灯します。 クリッピングが生じる場合は、関係するアウトプットレベルを下げてください。
(6) この LED は RIG KONTROL が MIDI 信号をシーケンサー、または他のコントローラーから受信した場
合に反応します。
(7) この LED はペダルの下にあるスイッチが起動している場合に点灯します。

3.2 リアパネル
 

RIG KONTROL のリアパネルです。

(1) Inst/Line スイッチでインプット 1 と 2 の入力感度を切り替えます。 スイッチを解除した状態で、イン
プットはギターやベース等の楽器に対応し、押した状態でライン入力に対応します。 選択したインプットタ
イプは機器のトップパネルでも表示します。
(2) このノブでインプット 1 のゲインをコントロールします。
(3) インプット 1 用ソケットで、(¼” ジャック、TRS バランスド) Line/Inst スイッチの設定により、各ライ
ン入力シグナル、及び楽器レベルシグナルに対応します。 ギター、ベース、キーボード、またはステレオ機
器の左チャンネルをここに接続します。
(4) インプット 2 用ソケットで、(¼” ジャック、TRS バランスド) Line/Inst スイッチの設定により、各ライ
ン入力シグナル、及び楽器レベルシグナルに対応します。 2 番目のギター、ベース、キーボード、またはス
テレオ機器の右チャンネルをここに接続します。
(5) このノブでインプット 2 のゲインをコントロールします。
(6) これらの端子からオーディオインターフェイスの音声を出力します。 ステレオ音声を使用するには両方
を使用してください。
(7) アウトプット増幅値は最大または –14dB に調節可能です。
(8) これとは別にヘッドフォンアウトプットボリュームも調節可能です。
(9) ステレオヘッドフォン端子です。

RIG KONTROL ハードウェア
リアパネル
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(10) 外部エクスプレッションペダル、フットスイッチ、ボリュームペダル、またはスイッチボックス用端子
です。
(11) RIG KONTROL には各一つずつのインプットとアウトプットを備えた MIDI インターフェイスを装備
しています。 RIG KONTROL から GUITAR RIG にコントロールメッセージを送信する MIDI は必要ありま
せんが、この機能により MIDI シグナルを他のアプリケーションに送信することが可能となります。
(12) USB ポートを使用して使用しているコンピューターに接続します。 ハードウェアを使用するには使用
しているコンピューターが USB 2.0 に対応している必要があります。 本機器は USB バスパワーを使用し
ています。 本機器を使用しているコンピューターの USB 2.0 に直接接続し、パワード対応していない USB
ハブの使用はしないで下さい。 USB ケーブルは USB フック等で常に保護された状態で使用してください。

RIG KONTROL ハードウェア
リアパネル
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4 Windows へのインストール
 

この章ではオーディオインターフェイスの設定の観点から、Windows 7 に RIG KONTROL ハードウェアを
インストールする方法について解説します。 コントローラーとしてフットペダルを GUITAR RIG で起動す
る方法、関連した MIDI 機能の使用方法に関しては、本マニュアルのセクション↑7, RIG KONTROL をコン
トロールインターフェイスとして使用するを参照してください。
GUITAR RIG ソフトウェアに関する詳細は、GUITAR RIG マニュアルを参照してください。 マニュアルは製
品 DVD、または GUITAR RIG メニューの Help > Open Manual > Japanese から閲覧可能です。

4.1 ソフトウェアインストール
 

管理者権を使用してログインしてください。 この時点では、まだ RIG KONTROL を接続しないでください。
1. 製品 DVD をブラウズし、セットアップファイルを探してください。 ダウンロードしたバージョンの

GUITAR RIG を使用している場合は、セットアップファイルを最初に解凍する必要があります。
2. GUITAR RIG セットアップファイル（"Guitar Rig 5 [バージョン名] Setup PC.exe") をダブルクリッ

クしてインストールを開始します。

Windows へのインストール
ソフトウェアインストール
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3. スクリーン表示の手順に従ってインストールを行ってください。 この手順に従うと、ソフトウェアをデ
フォルトフォルダにインストールします。

4. この作業中にシステム内の VST プラグインフォルダを指定する為の画面が表示されます。 VST プラ
グインが何かよくわからない場合、または GUITAR RIG をスタンドアローンモードのみで使用するこ
とが明確な場合はスタンダードな設定を使用します。 GUITAR RIG をホストソフトウェア内でプラグ
インとして使用したい場合は、インストールフォルダをホストソフトウェア用プラグインフォルダに指
定する必要があります。

Windows へのインストール
ソフトウェアインストール
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5. GUITAR RIG オーディオインターフェイス用ドライバのインストールを行う内容の質問が表示されま
す。 Install the Rig Kontrol 3 Driver にチェックを入れ、Next をクリックします。

6. 表示画面に従ってコンピューターを再起動してください。
すると、以下のアプリケーションがハードドライブ上に設置されます。
▪ GUITAR RIG は全機能を装備したスタンドアローンソフトウェアです。
▪ GUITAR RIG プラグインを使用してデジタルワークステーション (DAW) 上で GUITAR RIG をプラグ

インとして使用することが可能となります。 Windows で GUITAR RIG は VST または RTAS プラグ
イン形式で作動します。

▪ SERVICE CENTER – このアプリケーションで製品の起動とアップデートを行います。 詳細については
セットアップガイドを参照してください。

▪ RIG KONTROL のハードウェアドライバです。

ハードウェアドライバのみをインストールする場合は、インストール DVD のドライバ専用インストー
ルファイルを使用してください。 このファイルの最新バージョンは Native Instruments ウェッブサ
イトのサポートセクションから取得可能です。

Windows へのインストール
ソフトウェアインストール

 

RIG KONTROL 3 - オペレーション マニュアル - 15



4.2 ハードウェア インストール
 

付属の USB ケーブルを使用し、 RIG KONTROL を使用しているコンピューターの USB 2.0 ポートに接続
してください。

コントローラーをコンピュータに接続します。

RIG KONTROL は USB を使用して電源を供給します。 この機器を正常に作動するには単体の USB 2.0 コ
ントローラー、または電源を供給する USB 2.0 ハブの使用が必須です。
► ドライバが正常にインストールされると、 RIG KONTROL が自動検知されます。 認識されな
い場合は、ソフトウェアのインストールを上記で説明したようにもう一度行ってください。
いくつかのドライバモジュールが RIG KONTROL にアサインされるので、各ドライバのインストールが終わ
る度に小さなポップアップウインドウが表示されます。

Windows コンピュータでは、ドライバが特定の USB ポートを使用する場合があります。 USB ケー
ブルを接続したポートとは異なるポートに接続した場合、ドライバのアサインが再度行われます。

この時点でコンピュータが RIG KONTROL  を認識しない場合は、USB ケーブルをはずし、何秒か待
った後再接続してください。 それでも問題が解決しない場合は、インターフェイスを接続したままコ
ンピュータを再起動してください。

Windows へのインストール
ハードウェア インストール
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4.3 設定
 

この章では、RIG KONTROL オーディオインターフェイスを Windows 上で GUITAR RIG ソフトウェアと
共に使用する方法を解説します。 ここでは既に Service Center を使用して GUITAR RIG を起動したもの
として解説を進めます。 まだ製品起動（アクティベーション）を行っていない場合は Setup Guide を参照
して製品起動を行ってください。

4.3.1 GUITAR RIG の設定
 

それでは GUITAR RIG を設定し、RIG KONTROL オーディオインターフェイスを使用できる環境にしましょ
う。
► この設定を行う前に、ソフトウェアを起動しておいてください。
ソフトウェアを始めて起動する場合は、以下の設定を行うための Audio and MIDI Settings ウインドウが
自動的に表示されます（後にこの設定画面に進むには File > Audio and MIDI Settings と進んでください）。

Audio and MIDI Settings ウインドウです。

1. Audio タブで Driver ドロップダウンメニューから ASIO を選択します。
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2. Device ドロップダウンメニューで RIG KONTROL 3 を選択します。
3. 音楽ソフトと使用しているコンピュータの処理性能に適した Sample Rate を選択します。 デフォル

トでサンプルレートは 44100 Hz (CD の音声品質と同等) に設定してあります。 高いサンプルレート
（一般的な値は 44100 Hz です）で音質は向上しますが、CPU ロードも高くなります。

RIG KONTROL 3 がリストに表示されない場合は、何か問題があります。 セクション↑4.1, ソフトウ
ェアインストールで解説したように、インストールをもう一度行ってください。

詳細設定
ドライバコントロールパネルを使用した詳細設定に関しては↑5.4, オーディオ接続とレベルを参照してくだ
さい。.

4.3.2 RIG KONTROL をデフォルトオーディオインターフェイスとして
使用する

 

使用しているコンピュータの全ての音声再生用に RIG KONTROL を使用するには、本機器をデフォルトオー
ディオインターフェイスとして設定する必要があります。 Windows 7 での設定方法は以下となっていま
す。
1. Start > Control Panel > Hardware and Sound > Sound と進みます。
2. Playback タブを選択します。
3. 機器リストから、Rig Kontrol 3 Output を選択し、Set Default をクリックします。
4. Recording タブを選択します。
5. 機器リストから、Rig Kontrol 3 Input を選択し、Set Default をクリックします。

Windows へのインストール
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6. OK をクリックしてダイアログを閉じてください。

4.4 オーディオ接続とレベル
 

以下の章では、 RIG KONTROL にギターとモニターシステムを接続する方法を解説しており、またハードウ
ェア、ソフトウェア各での適切な音量設定についても解説しています。 この設定を行う前に、GUITAR RIG
を起動しておいてください。

4.4.1 楽器の接続とインプットレベルの調整
 

1. モニターシステムのボリュームを最小にしてください。
2. プリアンプ等を使用してライン音声を使用する場合を除いて、インプットセレクターをインプット

(RIGKONTROL の LINE/INST ボタンを押した状態にします) にしておきます。
3. ギター、またはベースからのケーブルを RIG KONTROL のインプットジャックソケットに差し込んで

ください。
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4. インプットを使用しない場合、ボリュームを最小に絞っておきてください。
ステレオ音声を出力する機材(シンセサイザー等)を接続する場合は、各ステレオチャンネルに接続してくださ
い。

接続端子にギターまたはベースギターを接続します。

インターフェイスを使用して十分な音量を維持しつつ音質を最適な状態に設定するには、 RIG KONTROL の
インプットレベルを注意深く設定する必要があります。 インプットレベルメーター を確認しながら、最適な
インプットレベルに調節してください。

メーター表示内容 意味

全 LED がオフの状態 入力シグナルが無い状態で
す。

LED が緑に点滅する状態 シグナルを入力しています。

LED が緑と赤に点滅する状
態

入力シグナルが大きすぎま
す。

インプット感度を調節する前に、ギターのボリュームノブを上げてください。 通常演奏する音量でコードを
弾き、インプットレベルメーターを確認してください。
1. 演奏しながら LED が赤表示するまで、選択したインプットジャックの隣にあるインプットレベルノブ

を上げてください。
2. その後赤色点灯しなくなるまでノブを微妙に下げていきます。思い切りコードを弾いても LED が赤色

点灯しない位置まで慎重に調節してください。
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これでインプット感度が最適な状態に設定となり、RIG KONTROL でクリッピングなく最大限のダイナミッ
クレンジ内で演奏することが可能です。

4.4.2 2 番目の楽器の接続
 

楽器同士の音量が殆ど同じ場合は、各インプットに異なる楽器を接続することも可能です。 2 番目の楽器を
もう一つのインプット端子に接続し、上記のようにインプットレベルを調節してください。

単一のチャンネルのみを使用する場合は、一方のチャンネルゲイン(Gain )ノブをゼロにします。

ステレオシグナルを生成する楽器を使用する場合は、両方のインプット端子をその楽器に使用することでステ
レオ音声を発生します。

4.4.3 GUITAR RIG のインプットレベル
 

ここではギターを RIG KONTROL に接続しており、 インプットレベルが適切に設定されている前提で(↑
4.4.1, 楽器の接続とインプットレベルの調整を参照)解説します。 ここからはソフトウェア上でインプット
シグナルを最適に設定します。
GUITAR RIG ウインドウのヘッダ部分を確認してください。そこにはチャンネルセレクター付きインプット
モジュール (L/R)、ノイズゲート、 リミッター付アウトプットモジュール、CPU 確認機能が備わっていま
す。

GUITAR RIG のソフトウェアヘッダです。

インプットメーター (Input Meter) では演奏時の音量を表示します。 ここにはインプットレベルをコント
ロールするボリュームフェーダーが備わっています。 ここでシグナルがクリッピングする直前までシグナル
レベルを上げてください。 このシグナル音量はレベルメーター (Level Meter) を見ながら、赤表示する手前
の音量に調節します。
1 本のギターを接続してある場合 GUITAR RIG は、モノシグナルを受信します。 インプットモジュールを
設定してこの信号を両方のチャンネルにルーティングすることも可能です。 デフォルトでは GUITAR RIG
は両方のインプットチャンネル (L と R が起動した状態) を使用するように設定されているので、インプット
チャンネルの片方がミュートした状態となります。 この設定を変更するには使用していないチャンネルを無
効にします。 インプットメーターの左にあるボタンのどちらかをクリックし (L または R)これで使用して
いるインプットチャンネルのみが有効となります。 これで両方のチャンネルにモノシグナルを送ります。

Windows へのインストール
オーディオ接続とレベル

 

RIG KONTROL 3 - オペレーション マニュアル - 21



4.4.4 アウトプットの接続
 

RIG KONTROL にはモニターシステムに接続する為の 2 つのモノアウトプットがあり、接続先はミキシング
デスク、または使用しているアクティブスピーカーとなります。 ステレオサウンドを聞くには、このアウト
プットの両方を接続する必要があります。 もう一つのステレオアウトプット端子 (TRS) はヘッドフォン用
です。

接続端子にスピーカーとヘッドフォンを接続します。

1. ボリュームを下げた状態で、アウトプットジャックをアンプのインプットに接続してください。
2. ヘッドフォンを使用する場合はアウトプットジャックに接続し、ヘッドフォンレベルが完全に下がった

状態で装着してください。
3. プリセットブラウザでプリセットの一つをクリックして選択してください。
4. 演奏しながら慎重にアンプのボリューム、または RIG KONTROL にあるヘッドフォンレベルを最適な

音量に調節してください。
ここまでの設定を完了したら、後は好きなように演奏するのみです。
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5 Mac OS X へのインストール
 

この章ではオーディオインターフェイスの設定の観点から、 Mac OS X に RIG KONTROL ハードウェアを
インストールする方法について解説します。 コントローラーとしてフットペダルを GUITAR RIG で起動す
る方法、関連した MIDI 機能の使用方法に関しては、本マニュアルのセクション↑7, RIG KONTROL をコン
トロールインターフェイスとして使用するを参照してください。
GUITAR RIG ソフトウェアに関する詳細は、GUITAR RIG マニュアルを参照してください。 マニュアルは製
品 DVD、または GUITAR RIG メニューの Help > Open Manual > Japanese から閲覧可能です。

5.1 ソフトウェアインストール
 

管理者権を使用してログインしてください。 この時点では、まだ RIG KONTROL を接続しないでください。
1. 製品 DVD の内容を閲覧し、そこで GUITAR RIG を探してください。 ダウンロードしたバージョンの

GUITAR RIG を使用している場合は、インストールファイルを最初に解凍する必要があります。
2. インストールファイルをダブルクリックしてインストールを開始します。
3. スクリーン表示の手順に従ってインストールを行ってください。
4. GUITAR RIG オーディオインターフェイス用ドライバのインストールを行う内容の質問が表示されま

す。 RIG KONTROL 3 ドライバを選択し、Continue をクリックします。
5. 手順が完了したらコンピューターを再起動してください。
すると、以下のアプリケーションがハードドライブ上に設置されます。
▪ GUITAR RIG は全機能を装備したスタンドアローンソフトウェアです。
▪ GUITAR RIG プラグインを使用してデジタルワークステーション (DAW) 上で GUITAR RIG をプラグ

インとして使用することが可能となります。
▪ SERVICE CENTER – このアプリケーションで製品の起動とアップデートを行います。 詳細については

セットアップガイドを参照してください。
▪ RIG KONTROL のハードウェアドライバです。

NATIVE INSTRUMENTS 製品をこれまでに使用したことがない場合は、スクリーンの指示に従ってレ
ジスターする必要があります。 NI ユーザーアカウントの作成と GUITAR RIG の起動の詳細に関して
は、Service Center のインスタレーションフォルダーに付属している Service Center クイックスタ
ートガイドとマニュアルを参照してください。

ハードウェアドライバのみをインストールする場合は、インストール DVD のドライバ専用インストー
ルファイルを使用してください。 このファイルの最新バージョンは Native Instruments ウェッブサ
イトのサポートセクションから取得可能です。
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5.2 ハードウェア インストール
 

付属の USB ケーブルを使用し、 RIG KONTROL を使用しているコンピューターの USB 2.0 ポートに接続
してください。

コントローラーをコンピュータに接続します。

RIG KONTROL は USB を使用して電源を供給します。 この機器を正常に作動するには単体の USB 2.0 コ
ントローラー、または電源を供給する USB 2.0 ハブの使用が必須です。
► ドライバが正常にインストールされると、 RIG KONTROL が自動検知されます。 認識されな
い場合は、ソフトウェアのインストールを上記で説明したようにもう一度行ってください。
いくつかのドライバモジュールが RIG KONTROL にアサインされるので、各ドライバのインストールが終わ
る度に小さなポップアップウインドウが表示されます。

この時点でコンピュータが RIG KONTROL  を認識しない場合は、USB ケーブルをはずし、何秒か待
った後再接続してください。 それでも問題が解決しない場合は、インターフェイスを接続したままコ
ンピュータを再起動してください。
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5.3 設定
 

この章では、RIG KONTROL オーディオインターフェイスを Mac OS X 上で GUITAR RIG ソフトウェアと
共に使用する方法を解説します。 ここでは既に Service Center を使用して GUITAR RIG を起動したもの
として解説を進めます。 まだ製品起動 （アクティベーション） を行っていない場合は Setup Guide を参照
して製品起動を行ってください。

5.3.1 GUITAR RIG の設定
 

それでは GUITAR RIG を設定し、RIG KONTROL オーディオインターフェイスを使用できる環境にしまし
ょう。 この設定を行う前に、ソフトウェアを起動しておいてください。
1. ソフトウェアを始めて起動する場合は、以下の設定を行うための Audio and MIDI Settings ウイン

ドウが自動的に表示されます。 後ほどこの設定を行う場合は、プログラムメニューから Guitar Rig >
Preferences と進んでください。

2. Audio タブで Driver インターフェイスとして CoreAudio を選択してください。
3. Device ドロップダウンメニューで RigKontrol3 を選択します。
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RIG KONTROL を接続している状態でもリストに表示されない場合は、何か問題があります。 セクシ
ョン↑5.1, ソフトウェアインストールで解説したように、インストールをもう一度行ってください。

オーディオインターフェイスでは以下のパラメーターの設定が可能です。
▪ サンプルレート (Sample Rate): 使用している音楽アプリケーションに対応したサンプル・レートを

選択してください。デフォルトでサンプルレートは 44100 Hz (CD の音声品質と同等) に設定してあり
ます。高いサンプルレートで音質は向上しますが、CPU ロードも高くなります。

サンプルレートでサウンドを 1 秒間にどれだけ録音/再生するか設定します。 高いサンプルレートに
なるほど音質がよくなります。44100 Hz (CD 規格) が一般的な値です。 録音媒体が CD である場合
はこの設定、または倍に設定します (88200 Hz)。 48000 Hz は DAT または DVD (映画) 用規格値
です。 96000 Hz 以上の値は DVD、 HD DVD、Blu-ray Disc で使用します。 サンプルレートを高く
するほど CPU ロードも高くなります。

▪ Latency: Latency スライダーを使用して、サンプル単位で表示されるオーディオインターフェイスの
バッファサイズを設定します。 バッファサイズを高くすると、リアルタイム音声処理中に生じるオーデ
ィオドロップアウト率が低くなります。 バッファのサイズは使用しているシステムの全体的なレイテン
シーに直接作用します。 バッファサイズを大きくすると、楽器を演奏してから音声が発音されるまでの
遅延が目立つようになります。

まずはデフォルトバッファサイズを設定してインストールを完了することを推奨します。 インストールが完
了してから、プリセットをロードし、再度 Audio and MIDI Settings でシステムに最適なレイテンシーを設
定してください。 設定は、楽器を演奏しながら Latency スライダーを左へ徐々に動かし、バッファサイズを
少しずつ小さくすることで行います。 音声のドロップアウト等が生じ始めたら、レイテンシースライダーを
右へとドロップアウト等のノイズがなくなるまで動かします。

5.3.2 デフォルトオーディオインターフェイスとして RIG KONTROL を
使用する

 

音声再生用に RIG KONTROL を使用するには、本機器をデフォルトオーディオインターフェイスとして設定
する必要があります。 Mac OS X では以下のように設定してください。
1. Apple メニューで System Preferences (システム環境設定) を選択します。
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2. パネルが開くので Sound をクリックします。

3. Sound Effects タブの Play sound effects through メニューで RigKontrol3 を選択します。
4. Output タブをクリックし、Choose a device for sound output リストから RigKontrol3 を

選択します。
5. Input タブをクリックし、Choose a device for sound input リストから RigKontrol3 を選択

します。

5.4 オーディオ接続とレベル
 

以下の章では、RIG KONTROL にギターとモニターシステムを接続する方法を解説しており、またハードウ
ェア、ソフトウェア各での適切な音量設定についても解説しています。 この設定を行う前に、GUITAR RIG
を起動しておいてください。
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5.4.1 楽器の接続とインプットレベルの調整
 

1. モニターシステムのボリュームを最小にしてください。
2. プリアンプ等を使用してライン音声を使用する場合を除いて、インプットセレクターをインプット

(RIGKONTROL の LINE/INST ボタンを押した状態にします) にしておきます。
3. ギター、またはベースからのケーブルを RIG KONTROL のインプットジャックソケットに差し込んで

ください。
4. インプットを使用しない場合、ボリュームを最小に絞っておきてください。
ステレオ音声を出力する機材 (シンセサイザー等) を接続する場合は、各ステレオチャンネルに接続してくだ
さい。

接続端子にギターまたはベースギターを接続します。

インターフェイスを使用して十分な音量を維持しつつ音質を最適な状態に設定するには、RIG KONTROL の
インプットレベルを注意深く設定する必要があります。 インプットレベルメーター を確認しながら、最適な
インプットレベルに調節してください。
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メーター表示内容 意味

全 LED がオフの状態 入力シグナルが無い状態で
す。

LED が緑に点滅する状態 シグナルを入力しています。

LED が緑と赤に点滅する状
態

入力シグナルが大きすぎま
す。

インプット感度を調節する前に、ギターのボリュームノブを上げてください。通常演奏する音量でコードを弾
き、インプットレベルメーターを確認してください。
1. 演奏しながら LED が赤表示するまで、選択したインプットジャックの隣にあるインプットレベルノブ

を上げてください。
2. その後赤色点灯しなくなるまでノブを微妙に下げていきます。思い切りコードを弾いても LED が赤色

点灯しない位置まで慎重に調節してください。
これでインプット感度が最適な状態に設定となり、RIG KONTROL でクリッピングなく最大限のダイナミッ
クレンジ内で演奏することが可能です。

5.4.2 2 番目の楽器の接続
 

楽器同士の音量が殆ど同じ場合は、各インプットに異なる楽器を接続することも可能です。 2 番目の楽器を
もう一つのインプット端子に接続し、上記のようにインプットレベルを調節してください。

単一のチャンネルのみを使用する場合は、一方のチャンネルゲイン (Gain ) ノブをゼロにします。

ステレオシグナルを生成する楽器を使用する場合は、両方のインプット端子をその楽器に使用することでステ
レオ音声を発生します。

5.4.3 GUITAR RIG のインプットレベル
 

ここではギターを RIG KONTROL に接続しており、 インプットレベルが適切に設定されている前提で (↑
5.4.1, 楽器の接続とインプットレベルの調整を参照) 解説します。 ここからはソフトウェア上でインプット
シグナルを最適に設定します。
GUITAR RIG ウインドウのヘッダ部分を確認してください。そこにはチャンネルセレクター付きインプット
モジュール (L/R)、ノイズゲート、 リミッター付アウトプットモジュール、CPU 確認機能が備わっていま
す。

Mac OS X へのインストール
オーディオ接続とレベル
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GUITAR RIG のソフトウェアヘッダです。

インプットメーター (Input Meter) では演奏時の音量を表示します。 そこにはソフトウェア全体ののイン
プットレベルをコントロールするボリュームフェーダーが備わっています。 ここでシグナルがクリッピング
する直前までシグナルレベルを上げてください。 このシグナル音量はレベルメーター (Level Meter) を見
ながら、赤表示する手前の音量に調節します。
1 本のギターを接続してある場合 GUITAR RIG は、モノシグナルを受信します。 インプットモジュールを
設定してこの信号を両方のチャンネルにルーティングすることも可能です。 デフォルトでは GUITAR RIG
は両方のインプットチャンネル (L と R が起動した状態) を使用するように設定されているので、インプット
チャンネルの片方がミュートした状態となります。 変更するには使用しないチャンネルを無効にします。
これで両方のチャンネルにモノシグナルを送ります。

5.4.4 アウトプットの接続
 

RIG KONTROL にはモニターシステムに接続する為の 2 つのモノアウトプットがあり、接続先はミキシング
デスク、または使用しているアクティブスピーカーとなります。 ステレオサウンドを聞くには、このアウト
プットの両方を接続する必要があります。 もう一つのステレオアウトプット端子 (TRS) はヘッドフォン用
です。

Mac OS X へのインストール
オーディオ接続とレベル
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接続端子にスピーカーとヘッドフォンを接続します。

1. ボリュームを下げた状態で、アウトプットジャックをアンプのインプットに接続してください。
2. ヘッドフォンを使用する場合はアウトプットジャックに接続し、ヘッドフォンレベルが完全に下がった

状態で装着してください。
3. プリセットブラウザでプリセットの一つをクリックして選択してください。
4. 演奏しながら慎重にアンプのボリューム、または RIG KONTROL にあるヘッドフォンレベルを最適な

音量に調節してください。
ここまでの設定を完了したら、後は好きなように演奏するのみです。

Mac OS X へのインストール
オーディオ接続とレベル
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6 詳細設定
 

6.1 Windows での詳細設定
 

Audio and MIDI Settings ウインドウの ASIO Config. をクリックして（ GUITAR RIG のファイルメニ
ューで File > Audio and MIDI Settings と進みます）ドライバコントロールパネルにアクセスします。 コン
トロールパネル下部で RIG KONTROL の接続状況を確認することができます。

Audio Settings ページを開いた状態の Control Panel です。

6.1.1 Audio Settings ページ
 

Audio Settings ページで、オーディオレイテンシー、サンプルレートの設定、機器の状況をモニターしま
す。 Audio Settings ページには 2 つのセクションがあり、それらは、Audio Processing と Device
Monitor です。

Audio Processing セクション
Audio Processing セクションではオーディオインターフェイスによるアナログ/デジタル、デジタル/アナ
ログ変換用各パラメーターを設定します。メニューは 2 つです。

詳細設定
Windows での詳細設定
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▪ Sample Rate: 使用している音楽アプリケーションに対応した最適なサンプルレートを選択してくださ
い。 サンプルレートを高くするほど CPU ロードも高くなります。 デフォルトでサンプルレートは
44100 Hz (CD の音声品質と同等) に設定してあります。

サンプルレートでサウンドを 1 秒間にどれだけ録音/再生するか設定します。 高いサンプルレートに
なるほど音質がよくなります。44100 Hz (CD 規格) が一般的な値です。 録音媒体が CD である場合
はこの設定、または倍に設定します (88200 Hz)。 48000 Hz は DAT または DVD (映画) 用規格値
です。 96000 Hz 以上の値は DVD、HD DVD、Blu-ray Disc で使用します。 サンプルレートを高く
するほど CPU ロードも高くなります。

機器を用いてソフトウェアを複数同時使用する場合は同じサンプルレートを使用しなくてはならない
ことに注意してください。

▪ Process Buffer: バッファサイズを小さくするほどコンピュータからオーディオソフトウェア、MIDI
コントローラーの操作に対する反応速度が速くなります。

オーディオをデジタル、またはアナログ変換する場合、オーディオドライバがデータをバッファとして
保管する必要があり(オーディオバッファ)、 これらは CPU によって処理、送信されます。バッファサ
イズが大きくなるほど、シグナルがアウトプットまで到達するまでの時間がかかります。 顕著な例と
してコンピュータのキーまたはコントローラーを操作してから音声が出力されるまでに遅ることがあ
げられます。 この遅れをレイテンシーと呼びます。 バッファサイズを下げるほどレイテンシー値も下
がります。 レイテンシーにはバッファサイズの他にも原因となる要素があります(例、CPU スピード
と RAM サイズ)。この設定の際は高いバッファサイズ設定から始めて、演奏と音声に問題がなくなる
までこの値を徐々に下げることで設定するとよいでしょう。オーディオインプットに問題が生じる場
合は、使用しているコンピュータの CPU では現在のバッファサイズが適切では無いことを意味しま
す。

▪ USB Buffer: Process Buffer メニューで満足行くレイテンシー設定を得られない場合は、このメニ
ューを使用します。 USB バッファサイズの値を下げることでオーディオレイテンシーを少なくしま
す。 音声にクリック音声等のノイズが入る場合は、音声に支障がなくなるまでバッファサイズを上げま
す。

Device Monitor セクション
Device Monitor セクションではオーディオインターフェイスの処理状況とシステムのアウトプットレイ
テンシーを表示します。ディスプレイ内容は 2 つです。
▪ Processing State: このモニターでは機器の現在の状態を表示します。 表示内容は以下の 3 つです。

◦ Idle: インターフェイスは接続された状態ですが、オーディオデータは送信されていません。

詳細設定
Windows での詳細設定
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◦ Streaming: ドライバが起動しており、音声を処理していることを示します。
◦ Panic: ドライバが起動停止した状態です。これはインターフェイス内のコミュニケーション中に処

理しきれない程 USB I/O エラーが生じたことを意味します。
▪ Output Latency: アウトプットレイテンシーの量をミリセカンド単位で表示します。

6.1.2 Diagnostics ページ
 

Diagnostics ページの情報は上級者向けとなっていますが、問題がある場合はこのページを参照することを
お勧めします。
Diagnostics ページには 3 つのセクションがあります。
▪ Drop-Out Detection: USB I/O エラーと、検出されたバッファアンダーラン (underruns) を表示し

ます。
▪ Connection Monitor: クライアント-ドライバコネクションと、検出された USB データエラーを表示

します。
▪ System Performance Test: パフォーマンステストを行いレイテンシー値を計測します。
▪ Information: ドライバとファームウェアのバージョンを表示します。トラブルシューティングへのリ

ンクもあります。

Drop-Out Detection セクション
Drop-Out Detection セクションには 2 つのディスプレイと 1 つのボタンを備えています。
▪ USB I/O Errors: USB のインプット/アウトプットエラーを表示します。USB I/O Errors の数値は

システムのオーバーロード回数を表示します。
▪ Buffer Underruns: バッファアンダーラン (Buffer underruns) はオーディオバッファを正確に処理

できなかった場合に生じます。 扱いきれない程のバックグラウンド処理が行われている場合、オーディ
オドライバとして機器を使用する音楽プログラム内の CPU 負荷が高すぎる場合にこのアンダーランが
生じます。

▪ Reset: このボタンをクリックしてエラーカウントをリセットします。

Connection Monitor セクション
Connection Monitor セクションには 2 つのディスプレイと 1 つのボタンがあります。
▪ Number of Clients: インターフェイスに接続してあるクライアントの数を表示します。マルチ ASIO

アプリケーションは個別に数えられ、WDM と WASAPI では 複数の WDM/WASAPI アプリケーション
でオーディオを再生していても、 単体 (1 個) として数えます。

詳細設定
Windows での詳細設定
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▪ USB Data Errors: USB データエラーをカウントします。程度の悪いケーブル、または非常に長いケ
ーブルは USB バスのデータエラーの原因となる可能性があります。

▪ Reset: このボタンをクリックしてエラーカウントをリセットします。

System Performance Test Section (システムパフォーマンステストセクシ
ョン)
▪ Current Latency: 下の Start ボタンをクリックして現在のレイテンシー値を表示します。
▪ Maximum Latency: 最新の計測情報から検出した最高値を表示します。

◦ Reset のクリックは Start を始めてクリックしたときとどうとの機能を果たします。 テスト過程
をリセットし、新規テストを行います。

◦ Stop をクリックするとテストが終了します。Maximum Latency 値は表示されたままとなりま
す。

Information セクション
Information セクションには 2 つのディスプレイと 1 つのボタンがあります。
▪ Driver Version: ドライバのバージョンをここで確認します。
▪ Firmware Version: ファームウェアのバージョンをここで確認します。
▪ Troubleshooting Guide: Show をクリックしてトラブルシューティングガイドを開きます。

6.2 Mac OS X での詳細設定
 

Mac OS X で全ての関連設定項目は Audio and MIDI Settings ウインドウからアクセスすることが可能で
す。 詳細は ↑5.3, 設定 を参照してください。

詳細設定
Mac OS X での詳細設定
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7 RIG KONTROL をコントロールインターフェイス
として使用する

 

RIG KONTROL は GUITAR RIG の使用に最適なハードウェアコントローラーとして機能します。 内蔵コン
トロール機能の他に、MIDI 接続用端子と外部フットスイッチ用端子、外部ペダル用端子各が備わっていま
す。 以下のセクションでは、これらの機能をフル活用する為のハードウェアの設定方法を解説します。
GUITAR RIG をコントローラーインプットにアサインする方法に関しては、スタートアップガイドと、アプ
リケーションマニュアルを参照してください。
RIG KONTROL を MIDI コントローラーとして使用するには、同封の Controller Editor ソフトウェアを使
用してください。 詳細については コントローラーエディターマニュアルを参照してください。

7.1 GUITAR RIG で RIG KONTROL を起動する
 

RIG KONTROL はハードウェアを接続すると、自動的に GUITAR RIG 内で起動します。 初回起動の再にウ
ィンドウが表示され、ペダルのキャリブレーションを行うか問われます。 ペダルの稼動範囲全体を最初から
最後までなぞるように踏み込み、OK をクリックします。 キャリブレーションを再度行う場合は、オプショ
ン (Options) ページで環境設定 (Preferences) を選択します。 RIG KONTROL Pedal Calibration
の隣にある Reset ボタンをクリックしてください。
RIG KONTROL ハードウェアには GUITAR RIG 内の視覚表示部(ラックの上の Rig Kontrol ボタンをクリ
ックして表示/非表示)に対応する部分が備わっています。
GUITAR RIG をホスト内等で複数起動している場合、どのインスタンスをフットペダルでコントロールする
のか指定する必要がある場合があります。 デフォルトでは、最初に起動した GUITAR RIG に対して RIG
KONTROL が対応するよう設定してあります。 他のインスタンスの Virtual Kontrol の Connect LED を
クリックすることで RIG KONTROL が対応するよう切り替えることが可能です。一個以上のインスタンス
をコントロールすることはできません。
いくつかの機能はデフォルトでフットスイッチの 5-8 にアサイン済みで、ハードウェアでそれらの機能を表
示しています。 ブラウザ内で確認可能なプリセットは 5 (Preset Prev)と 6 (Preset Next)のスイッチで
切り替えることが可能です。 スイッチ 7 と 8 はそれぞれチューナーと、タップテンポ入力機能です。 これ
らのボタンはもちろん自由に他の機能をアサインすることが可能です。
簡単に RIG KONTROL のボタン、またはペダルに各機能をアサインするには Virtual Kontrol から各機能の
どれかをドラッグし、コントロールしたいパラメーター上でドロップします。 コントローラーアサインの詳
細については、スタートアップガイド、またはアプリケーションマニュアルを参照してください。

RIG KONTROL をコントロールインターフェイスとして使用する
GUITAR RIG で RIG KONTROL を起動する
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7.2 RIG KONTROL MIDI と MIDI コントローラーの併用
 

MIDI メッセージを送信して他のアプリケーションをコントロールしながら、USB を介して RIG KONTROL
と GUITAR RIG がやり取りを続けることは可能です。 MIDI インターフェイスにはインプット/アウトプッ
トチャンネルが備わっています。
MIDI インプット端子に接続されたコントローラーを使用するには、GUITAR RIG 内で RIG KONTROL MIDI
チャンネルを起動しているか確認してください。
1. Audio and MIDI Settings を開いてください。 Windows では File メニューにあります。 Mac OS

では GUITAR RIG メニューにあります。
2. MIDI タブを開きます。
3. Inputs テーブルで Rig Kontrol を指定し、Status  をクリックして起動します。
MIDI インプットチャンネルは GUITAR RIG の Options ペインで設定することができ、チャンネル設定は
Preferences タブの MIDI channel ドロップダウンメニューをクリックし、1-16 チャンネル、または
omni を選択します。 外部 MIDI コントローラーへの機能のアサイン方法に関しては、スタートアップガイ
ド、またはアプリケーションマニュアルを参照してください。

7.3 追加フットスイッチとペダルの使用
 

RIG KONTROL には外部フットスイッチ/ペダル用端子を装備しています(¼” パッチケーブル使用) 。 接続
と設定を行うことで、GUITAR RIG の MIDI コントローラーと同様にアサイン可能となります。 スタートア
ップガイドと、アプリケーションリファレンスマニュアルを参照してください。
GUITAR RIG の Options ページにある Preferences では以下の各設定選択肢があります。
► 外部ペダルをキャリブレートするには、 RIG KONTROL Ext Pedals Calibration  の隣にあるリセット
ボタンをクリックします。RIG KONTROL Ext Pedals Calibration

2 列分の RIG KONTROL Ext Pedal 1/2 Mode で、各インプットで使用する外部フットスイッチ、ま
たはペダルを指定します。 ペダル、またはスイッチの仕様書を確認してから指定を行ってください。
設定によって支障が生じる場合は、他のモードを試してください。

RIG KONTROL をコントロールインターフェイスとして使用する
RIG KONTROL MIDI と MIDI コントローラーの併用
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8 トラブルシューティング (Troubleshooting)
 

ハードウェアに問題がある場合は、テクニカルサポートに連絡を取る前に、以下の手順で問題解決方法がある
か確認することを推奨します。
▪ NI のオンラインナレッジベース (Knowledgebase ) を参照してください。 GUITAR RIG メニューから

Help > Visit the Knowledge Base... と進んで表示するのが最も簡単な表示方法です。
▪ 当社ウェブサイトの NI User Forum は以下となります。

http://www.native-instruments.com/forum/
テクニカルサポートチームに連絡を取る場合は、使用しているコンピューターの性能に関する情報も添えてく
ださい。 ドライバのバージョン情報とファームウェアの情報については、ドライバコントロールパネルを確
認してください。
▪ Windows コンピュータではドライバとファームウェアバージョンの確認は RIG KONTROL のコントロ

ールパネルで行うことができます。 Native Instruments のソフトウェアフォルダから Rig Kontrol 3
フォルダを開き、Rig Control 3 Control Panel をダブルクリックします。 各情報を表示するには
Help > About Rig Kontrol 3 Control Panel と進みます。

▪ Mac OS X コンピュータでは、システム環境設定からドライバコントロールパネルにアクセスします。
メインウインドウに各情報が表示されます。

サポートチームに連絡を取るには、この URL を訪れてください。
http://www.native-instruments.com/support/
Native Instruments の全製品は開発の段階から実際の使用状況を想定して繰り返しテストを行っていま
す。 製品を返却する場合はテクニカルサポートチームが RA (Return Authorization、返品確認) をし、迅速
に対応します。 どんな製品でも返品を行う際は必ず事前にテクニカルサポートチームへご連絡ください。
この RA を記載しないまま製品を返却すると、身元証明の妨げとなり、確認作業が確実に進行しない可能性
があります。

8.1 オーディオに関する問題解決法
 

このセクションではオーディオに関して頻出する問題に対応しています。

8.1.1 音が出ない、音量が極端に低い。
 

音が出ない、または音量が小さい場合は幾つかの原因が含まれます。
▪ ケーブルが破損している、または接続されていない。すべての接続端子とケーブルを確認してください。
▪ サウンドカード、またはオーディオインプットの選択が正しくない。 GUITAR RIG メニューから Audio

and MIDI Settings を選択し、 RIG KONTROL ドライバが選択されているか確認してください。

トラブルシューティング (Troubleshooting)
オーディオに関する問題解決法
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▪ GUITAR RIG のインプットモジュール内で異なるチャンネルを選択している。 楽器を他のインプット
ジャックに接続するか、ユーザーインターフェイスのヘッダから他のチャンネルを選択して切り替えま
す。

▪ RIG KONTROL のインプットゲインの設定値が低すぎる。 インプットレベルを上げてください。
▪ 使用している楽器の音量を上げていない。ボリュームノブを調節してください。

8.1.2 音声が歪む
 

GUITAR RIG ソフトウェアのディストーションエフェクトを使用していないのにオーディオシグナルが歪ん
でいる場合は、殆どの場合 RIG KONTROL のゲインが高く設定され過ぎていることに起因します。 インタ
ーフェイスのインプットレベルを下げプリアンプのクリッピングを回避してください。 楽器自体の音量が大
きくプリアンプが常時オーバードライブする場合は使用している楽器の音量を下げてください。 通常この現
象は、使用している楽器に高パワーピックアップが備わっている場合に起こります。

8.1.3 ノイズ
 

ハムノイズが起きる原因は様々です。以下はノイズ発生例です。
▪ シングルコイルピックアップは電気的干渉を集めやすい特性を持っています。 ハムバッカー

(Humbucker) ピックアップは名前が示すとおり、ハムノイズ発生量が比較的少ないです。
▪ 使っているギターが電気機器に近すぎる。この種のハムノイズを減少させるには、ノイズ発生の原因とな

っている機器からギターを遠ざけてください。
▪ ギターのボリュームノブ音量が小さく設定されている。ノブを上げてください。使用しているギターが

一つ以上のノブを備えている場合は各ノブを確認してください。
▪ ケーブルが破損している。ギターシールドが適切ではない場合もあります。シールド加工してあるケー

ブルと交換してください。改善されない場合は専門家に相談してギター自体を修理してください。
ヒスノイズが生じる場合は、 RIG KONTROL のインプットレベルが極端に低くないか確認してください。
楽器の音声または、 RIG KONTROL のインプットレベルを上げてください。 インプットレベルの設定につ
いては、本マニュアルのセクション 4.4 (Windows) またはセクション 5.4 (Mac OS X) を参照してくださ
い。

8.1.4 グラウンドループ
 

グランドループ (ハム、またはバズノイズ) は複数の電気機器を同一電源に接続した場合に起きる一般的な問
題です。 これらのノイズを回避するには以下の手順を実行してください。
► 使用していない機器の接続を全て外して下さい。例)コンピュータに接続している周辺機器 (外
付けデータ保存機器、CD/DVD バーナー等)。
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► RIG KONTROL アウトプット以降に DI ボックスを備え付ける。 殆どのボックスはグランド
リフトスイッチを備えており、ループに干渉してノイズを取り払います。

8.2 ハードウェアに関する問題
 

RIG KONTROL ドライバアップデートとその他の情報に関しては、Native Instruments ウェブサイトとサ
ービスセンターで確認してください。

8.2.1 ドライバの問題
 

RIG KONTROL がコンピューターに接続してあるのを確認してからコントロールパネルを開きます。 この
章の導入部を確認し、ドライバコントロールパネルの参照方法を確認してください。
コントロールパネルが見つからない場合はドライバをインストールしていない可能性が高いです。 この場合
は、本マニュアルに従って、ドライバを再度インストールしてください。
ドライバコントロールパネルのドロップダウンメニューが全て灰色表示の場合は、RIG KONTROL がドライ
バに認知されていないことを示します。 この場合、USB 接続に問題がありますので、以下セクションで確認
を行ってください。

8.2.2 USB の問題
 

RIG KONTROL は USB 2.0 インターフェイスで、USB 1.0/1.1 ポートでは動作しません。 常に直接コンピ
ュータの USB 2.0 端子に接続してください。 この USB 2.0 ポートは最小電力を (500 mA) を必要としま
す。 コンピューターによっては USB 2.0 の使用必要条件を満たさないので USB 2.0 を使用することが出
来ません。 この場合、機器を有効に作動させるための電力が無いという趣旨のメッセージが現れます。 この
まま RIG KONTROL  を使用すると、雑音が生じる、または完全に作動しない場合もあります。
▪ 使用しているコンピュータが十分なバス電源を供給しない場合は、 RIG KONTROL を外部電源供給機能

付 USB 2.0 ハブに接続してください。 全ての機器の電源量総量が減少する原因となるので、ハブにその
他のパワードバスハブを接続しないで下さい。

▪ 以上を行っても問題が改善されない場合は、RIG KONTROL 以外の全ての USB 機器の接続をはずして
動作確認を行ってください。

▪ オーディオドロップアウトが生じる、または USB に関連するその他の問題が生じる場合は、RIG
KONTROL を他の USB 2.0 ポートに接続してください。

▪ 古くなった USB ケーブルがオーディオドロップアウトの原因となったりその他の問題の起因となって
いる場合もあります。正式な USB ロゴ表示のあるケーブルを使用してください。短いケーブルが有効
な場合もあります。
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▪ RIG KONTROL がウインドウズ上で頻繁にクラッシュしたり正確に動作しない場合、デフォルトではオ
ンになっている USB ハブの電源マネージメントをオフにする方法があります。 デバイスマネージャへ
行き(Control Panel > System > Hardware)、USB ハブを右クリックして、プロパティを開いてくださ
い。 パワーマネージメントページでこのチェックボックスのチェックを解除します。 各ハブについて
これを繰り返し、再起動してください。

8.2.3 ラップトップで RIG KONTROL を使用する
 

始めに、使用しているコンピュータにオーディオドロップアウトがなく、リアルタイムオーディオ処理に適し
ているかを確認してください。以下のフリーウェアでシステムを分析し、確認することが可能です。
www.thesycon.de/deu/latency_check.shtml
RIG KONTROL を接続していない状態で、この確認ツールを起動してください。 コンピューターがオーディ
オ処理に対応していない場合は、レイテンシーバーが赤く表示され、下のボックスにリポートを表示します。
一般的に共有メモリグラフィックカードをラップトップに使用することは推奨されていません。オーディオ
処理を円滑に行うには十分なメモリと的確な処理精度が必要です。
ラップトップをライブ用に使用するには、以下の点を確認してください。
► ラップトップをバッテリーのみで使用すると、パワーマネージメントシステムがバッテリーを
節約し、CPU のクロックレートを遅くすることがあるので、バッテリーのみの使用は推奨しませ
ん。
► 演奏中に使用しない機器は外して下さい (例、プリンター、スキャナー等)。 使用しない機器を
外すことで音楽ソフトに対する処理能力が向上します。
► ラップトップにはオーディオ処理を妨げるネットワークアダプターや、ワイヤレス LAN カード
等の内蔵デバイスが装備されていることが多々あります。 これらの機器も RIG KONTROL を使
用している時は、無効にしておく必要があります。

トラブルシューティング (Troubleshooting)
ハードウェアに関する問題

 

RIG KONTROL 3 - オペレーション マニュアル - 41



9 技術仕様書
 

このセクションでは RIG KONTROL ハードウェアに関する技術的仕様を記載しています。

9.1 ジャックと端子
 

▪ 2 input jacks (In 1, In 2) for mono 6.3mm (1/4 inch) phone plugs
▪ 2 output jacks (Out 1, Out 2) for 6.3mm (1/4 inch) mono (unbalanced) or TRS (balanced)

phone plugs
▪ 1 Headphones jack for stereo 6.3mm (1/4 inch) phone plug
▪ 2 input jacks for external pedals / footswitches / switchboxes
▪ (Pedal 1, Pedal 2) for stereo 6.3mm (1/4 inch) phone plugs
▪ 2 MIDI (In/Out) 5-pin DIN circular connector
▪ 1 USB 2.0 Type B

9.2 オーディオ仕様
 

オーディオインプット (A/D)  

チャンネル 2

Sample Rate (サンプルレート) 44.1, 48, 88.2, 96, 192 kHz

ビット解析度 16, 24 Bit

コンバーター Cirrus Logic

 

インストゥルメントインプット  

インプットインピーダンス 1M Ohm

フルスケールレベル (最大ゲイン時) -11,5 dBu

最大インプットレベル +16dBu

SNR (weighted) > 100 dB

THD+N 00,009%
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インストゥルメントインプット  

周波数特性 +/- 0,5 dB, 20 Hz – 24 KHz

ダイナミックレンジ 105 dB (ADC)

 

ラインインプット  

インプットインピーダンス 44 KOhm

フルスケールレベル(最大ゲイン時) -5,5dBu

最大インプットレベル +16dBu

SNR (weighted) > 100 dB

THD+N 00,009%

周波数特性 +/- 0,5 dB, 20 Hz – 36 KHz

ダイナミックレンジ 105 dB (ADC)

 

オーディオアウトプット (D/A)  

チャンネル 2

Sample Rate (サンプルレート) 44.1, 48, 88.2, 96, 192 kHz

ビット解析度 16, 24 Bit

コンバーター Cirrus Logic

 

ラインアウトプット  

アウトプットインピーダンス 100 Ohm

最大アウトプットレベル +6,3dBu

SNR (weighted) > 100 dB

THD+N 00,010%
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ラインアウトプット  

周波数特性 +/- 0,5dB 22Hz – 44KHz

High/low レベルスイッチ Full scale 5Vpp / -14dB

 

ヘッドフォンアウトプット  

負荷インピーダンス 8-600 Ohm

最大アウトプットレベル 1,61V rms @ 100 Ohm

SNR (weighted) >91dB

THD+N (60 Ohms) 00,013%

周波数特性 +/- 0m5dB 22Hz – 44KHz

9.3 電源
 

USB 2.0 インターフェイス使用、5V 500mA バスパワー。 USB パワーを使用するのみで追加電源やバッテ
リーを必要としません。 しかし RIG KONTROL 単体のみを USB 2 コントローラー、またはパワード USB
2 ハブを介して使用する場合の正常動作を保障するものとします。

9.4 寸法と重量
 

▪ 寸法: 360 x 237 x 102 mm (14.1 x 9.3 x 4 in)
▪ 重量: 2.6 kg (5.7 lb)

9.5 環境仕様
 

▪ 作業可能気温: 0˚C から 40˚C /32°F から 104°F (85% 凝縮湿度ではない通常湿度)
▪ 保管気温: -20  C から 50°C /-4°F to 122°F (85% 凝縮湿度ではない通常湿度)

9.6 動作環境
 

▪ Mac OS X 10.6、Intel Core Duo、1 GB RAM、USB2.0
▪ Windows 7 (最新の Service Pack、32/64 Bit)、Intel Core Duo または AMD Athlon 64、1 GB

RAM、USB2.0
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